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Introduction 

Thank you very much for purchasing the product of our company. 

This user manual for the program describes the method of parameter edition and modification of 

the products with the software. 

 

 

Notification Regarding the Manual 

 This user manual is a protected document with the publisher rights law. 

 You may not copy, communicate to the public, distribute, translate or change to an 

unreadable format without the written permission of the Samwon Tech. Inc. 

 Please make sure the final user keeps this manual and keep it at a place you can reach 

at any time. 

 Please read the manual thoroughly before using the software. 

 This manual is for providing details and directions on using the product and does not guarantee 

any other problems occurring. 

 The contents of the software manual may be edited both with and without advance notification. 

 Although the software manual is written with full effort, if you find any typing errors or omissions 

please notify the place of purchase or the sales department of the company. 

 

About the Exemptions with the Product 

 The company holds no guarantee or responsibility for any circumstances other than what is 

mentioned in the quality assurance. 

 The company holds no responsibilities for any direct and indirect losses of a user or a third party, 

caused by an unexpected error or a natural disaster. 

  

Revisions 

January 2014 1st Edition 
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Consent to Software Copyright 

Important – Please check before installing and using the product 

 Please read thoroughly before installing the software. The user policy for a final PME user (“user 

policy”) is a legal contract signed between the Samwon Tech Inc., software seller, a company with 

the using right and a user regarding the “software.” 

 Installing the “software” indicates that the user has fully read and understood the “user policy” 

and have agreed with it. 

 

License Policy and Management 

 

 I agree to use the “software” and the document only by the compliance with all laws of the 

region of use, including the terms related to the copyrights and other intellectual properties (not 

limited). 

 This “Software” is subjected to protection by the copyright law and the program protection law 

and it cannot be modified, subjected to reverse engineering, decompiling or disassembling 

unless within the restriction boundary stated in relevant law. In addition, the device and relevant 

prints cannot be copied or distributed without a permission of Samwon Tech. Inc. in advance. If a 

damage has occurred in violation of the copyright act, SamwonTech Inc. may claim and demand 

for compensation for any damages caused by the violation of copyrights. 

 This “Software” cannot be rented, transferred, distributed or resold to another without a written 

permission (Email, Fax, etc.) of the Samwon Tech Inc. 

 This “Software” is for the certain group of products of Samwon Tech Inc. and is provided as a 

free give for those who purchased the product. 

 The right, ownership, authority and intellectual property right on this “Software” is held by 

Samwon Tech Inc. This software is under protection of the international copyright agreement. 

 All problems that occur during installation and operation of this “Software” are at the user’s 

discretion and risk. 

 This “software” does not guarantee any errors, bugs, security and performance, and does not 

assure that all errors on the software will be modified. 

 In case a user of the software violates the use agreement, the contract of using right 

automatically ends. No notification is required in such end of contract. A user can terminate the 

contract of using the software at any time by uninstalling (remove program) the software.  

 

Copyright(C) 2013 samwontech.com, All rights reserved. 
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Description of Important Symbol Marks and Units 

In this program user manual, any warnings and important messages are indicated after the symbols 

listed below. Please look at the symbol marks carefully to help understanding of the manual. 

Unit  

K Denotes 1024 Byte or Kbyte 

k Denotes 1000 

Notes  

 
Indicates “warning” or “notification”. The company is not responsible for any 

problems caused by matter of violation. 

 Additional explanation to help understanding the earlier description. 

 Provides the references and pages to refer. 

 Indicates controls with mouse. 

 

Products on which the Software Manual Applies 

 TEMI1000 : Programmable Temperature and Humidity Controller 

 TEMP1000 1, 2 Loop : Programmable Controller 

 

List of Modifications Made on the Program 

Edition Update Date 

1 Program release ver. 1.0a 

TEMI/TEMP1000 series driver files support 

January 2014 

2   
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1.1 INTRODUCTION TO PME 

1.1.1 Main Features 

The Parameter Map Editor, PME, is PC software for setting parameters for the inner operation of the 

products, TEMI1000 and TEMP1000 series from the Samwon Tech Inc. You can check, edit and compare 

the D-Register inside the products and also set the same parameters for many different products by 

saving the information as map files. 

 

Operates Offline 

Communication between the products is not necessary for setting parameters for each product. The 

software operates offline the way the user has set already. If there is any changed made by the user, 

the linked parameters operate the same as the products. 

 

Saving and Opening Parameter Files 

A parameter data set by the user can be saved as a file in local PC and the file can be opened on 

another PC by sending with email or copying. In case of display damages and A/S requirements, you 

may preliminarily diagnose by sending the parameter files first. 

  

Upload & Download Parameter Data 

You may download the user set parameter files through a communication setting between products or 

upload the parameter files using PC. Also you can download a same parameter on many different 

products continuously. 

 

Automatic Product Type Check 

Even if the version and type of the user’s product is unknown, it automatically reads the product details 

including the model name and version of the connected product to establish the right parameter 

setting environment for the product. 

 

1.1.2 Installation and Update Version Management 

This program can be installed on the Microsoft Window (32, 64bit) operating system and the recent 

program can be checked on the company website (www.samwontech.com). 

 

 
Information  

 This program is for setting parameters for a specific hardware system. Although an 

independent operation of the program is possible without certain product, it could only be 

used for transferring saved files of parameter settings. 

 

http://www.samwontech.com/
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1.2 OPERATION SYSTEM REQUIREMENTS 

1.2.1 Hardware 

This program requires PC that satisfies the following minimum requirements to operate. 

Item Requirement Note 

Operation System WindowXP, Vista, 7, 8 32, 64Bit 

CPU Pentium or higher  

Memory 1G  

Communication Environment Serial (RS232), Ethernet Check supported options by 

products 

Other Programs Microsoft Excel 97 or higher Required to convert files 

 

1.2.2 Other Operation Environment 

 Serial communication cable or Serial to USB converter cable 

 For the products that provides ethernet communication option, etnernet communication cable and 

RJ45 connector are required 

 Adobe Reader 7 or later version is required to read this manual. 

 Product (option) for the DownloadUpload task of the product 

 

 Information  

 You may check the details of the products that supports program  “Introduction- Applicable 

products” 
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1.3 MAIN SCREEN AND MENU OF THE PROGRAM 

1.3.1 Main Menu 

This program is composite of the main list output window that gives each parameter data of programs, 

group tree window that is arranged by parameter groups, user log output window that gives user 

message and process result and the user command menu. 

 

 

 

Ribbon Menu 

The program menu has the main menus and the respective sub menus. You can quickly choose a 

desired function by arranging the main menu with common options. The icons of sub menu will appear 

once you click on a main menu. 

 
 

  

Main menu 

Sub menu 

Register Group  

Tree View 

Link to homepage 

Setup the style 

 Register 

description 

Main register list 

System message log 

Sub Menu 

Main menu 
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Parameter Output List Window 

You may get the output of the product register information or view/edit the selected product register 

information. The registration information is listed in rows and you can activate the edit mode by 

clicking on your mouse. The details of selected register are available on the “Register Description” 

window. 

 

 

 

Registry Group Window 

The whole registers are given in a form of a tree of groups of similar objectives. You can view the list of 

registers under a group if you extend a group by clicking on the node. Once you click on the group 

you can open it and it will be presented on the list window.  

 

Each group of register is arranged / written with the screen interface base of the product, but due to 

the program’s characteristics a merged or transferred item may appear. 

 
Information  

 A message of warning may appear if you select a group that influences the “INPUT SET” or other register 

information. 

 The arrangement of each group may differ depending on the type of the product. 

Edit area 

Registry Group 

Sub item Refresh list 
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System Message Output Window 

It presents any system messages during the program operation or gives the output of the register 

search / comparison processes. Other than these, it could also show the causes and solutions to errors 

occurring. For a message that has an address of a register, you can move to the register by double 

clicking on it. 

 

 

 

 

 

  

Move to selected register 

group 
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1.3.2 Menu Composition 

The program menu consists of the main menus on the top and sub menus that belong to each main 

menu. The description of each menu is below.  

 

Description of Sub Menus 

Main Menu Sub Menu Working 

File 

New Project Select the product type of the selected item and create a new parameter. 

Open Open a previously saved file and reopen the screen. 

Save Save the selected parameter as a file. 

Save as Save the selected parameter as a new file. 

Upload Set the parameter from a connected product on PC. 

Download Apply the selected parameter on the product. 

System 

Convert to Excel Convert the currently selected parameter as an excel file. 

Convert to Text Convert the currently selected parameter as a readable text file. 

Convert to CSV file Convert the currently selected parameter as a CSV file. 

Reset Factory reset every values set by the user. 

Parameter 

Comparison 

Compare and output the result of the comparison between connected 

product and the currently set values. 

Search Search register by key words like tag names and descriptions. 

Reset User Log Delete all log history listed at the bottom of the log window. 

Setting 
Hide Status Bar Hide or show the program status bar. 

Hide Caption Bar Hide or show the program caption bar. 

Help 

Current File 

Information 

Show information on the file you are currently working on. 

Program 

Information 

Show program information. 

 

The main menu is grouped by main features of the program and it consists of “File”, “System”, “Setting” 

and “Help”. When you click on a main menu, the sub menus under it will appear in the tool bar at the 

top of the program.  

 
Information  

 The output language of menu is the same as the language of the OS it is operating on. For any other 

languages than Chinese, English and Korean, the default language, English, will be the output language. 

 The command to convert to excel file requires Microsoft Excel 97 or higher version installed on the system 

the program is running on. (Except for CSV files) 
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1.3.3 Flow of Program Operation 

The basic order of the product operation supported by this program may differ depending on the 

product but generally the operation follows the order described below. 

General Order of Program Operation 

Procedure  

1. Start Start the program. 

2. Open 

Open an existing file. 

Create a new project. 

Upload from a product. 

3. Edit 

Enter the setting for entering sensor first if it exists. 

Enter the settings for maximum / minimum value for entering sensor. 

Edit other parameter information. 

4. Save 

Save the entered parameter information as a dedicated file. 

You can convert to a file of Excel, Text or CSV. 

Enter the print setting and print. 

5. Setting 

Set the communication environment for transferring parameters and 

select the device. 

Transfer the parameter information to a device. 

6. Finish 

Start “Parameter Comparison” to see if the information is properly read by 

the product. 

Close the program. 

 

 Warning  

 For the safety of the user, this program is constructed to not to download when the product is driving or the user password 

is wrong. 
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Workflow 

The following describes the general program workflow. 

  

Start 

New file Open file Upload data 

Configuration 

Edit Edit 

Download 

Print 

Export 

End 

Save to file 

Update data 

Save data 

Connect? 

Display window Connect? 

YES 

YES 

YES 

YES 

YES 

NO 

NO NO 

NO 

NO 

YES 



Chapter 1 INTRODUCTION TO PME 

SAMWONTECH Co., Ltd. www.samwontech.com Page 17 

1.4 PREPARING HARDWARE 

1.4.1 Prepare for Program Operation 

This program is a PC software for setting operation parameters for TEMI1000 and TEMP1000 product 

series of Samwon Tech Inc. Editing and saving each parameter under offline-base are available without 

a product, but you must prepare cables for communication with a product and set other settings in 

order to run “Upload”, “Download” and “Parameter Comparison” that are operated by communicating 

with the product. 

 

Installation of the Program 

Download the latest version of the program on the company’s website (www.samwontech.com), select 

and install the execution file. 

 

 

 

http://www.samwontech.com/
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Operation of the Program 

Once the program is successfully installed, click on the “Start Window” button and select the “PME 

(Parameter Map Editor)” under “SAMWONTECH.”  

 

         

  

Program start 
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Information  

 The program installs automatically in order of the command outputs. 

 The files and folders that appear after installation are essential in operating the program, so do not delete, move or change 

file name. 

 If error is occurred while installing under a Window operation environment, please contact the place of purchase or the 

head office of the company. 

 

1.4.2 Communication Environment Setting 

This program supports serial (RS232) and Ethernet communications for communication with the 

products. For the method of connecting the PC and a product with a cable, please refer to the “product 

installation manual”. 

 

Serial Communication Environment Setting 

1 Check the communication environment setting of the product (refer to product installation manual) 

2 Check the COM PORT of user’s PC 

 “Control Panel” → “Device administrator” → Check the communication port number from “COM & LPT Port” 

 It may appear as the product name if you are using the “USB to Serial cable.” 

 

 

 

Check COM PORT Number 
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Ethernet Communication Environment Setting 

In case of using the Ethernet communication, you must check whether the device product supports the 

communication. Depending on the specification of some devices the Ethernet communication may not 

be supported. 

 

1 Check the communication environment setting of the device (refer to product installation manual). 

2  Ethernet network setting of the user’s PC 

 “Control Panel” → “Network and Internet” → Click on “Change Adaptor Setting”  

 Select network adaptor, then “Ethernet properties”  

 Select “TCP/IP v4” from the list then click on “Properties”  

               

3  Ethernet Network Environment Setting 

 Check “Use the following IP address”  

 Enter the “IP address”, “Subnet Mask” and “Default Gate Way” 

- The values of subnet mask and default gate way are the same as the ones in the device setting. 
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4  Finish and check the network setting 

 Check the IP address in the settings of device 

 “Start” → “Search” → Run “CMD”  

 Enter the “Ping product IP address” and press enter  

 Check the output result and response 

Setup ethernet options 
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2.1 CREATE NEW PROJECT 

2.1.1 Checking Device Type and Information 

The program has built-in driver files that enable the operation of each device. When you start new 

project on the program, it loads the driver file that matches with your device to renew the parameter 

map. There are 3 ways in which the program distinguishes the devices and drivers. 

 

Create New Project 

In order to set the parameters that are suitable for desired object, click on the “new project” to edit and 

change the file based on the default settings of the device.  

 

                              

 

Automatic Device Identification 

If the communication environment between the PC and device is set, the driver for connected device 

can be automatically identified with the command at “New Project” → “Automatic Product Check”. The 

name of identified device and the result of the automatic check is viewed in the “Program Log View” 

and you must check whether the communication with the device is ready from the communication 

environment setting. 

        

 

 

Upload  

It is a method of uploading the current parameter to connected device. If the communication 

environment between the device and PC is set, you can start editing through the communication 

between the products based on the parameter set on the device.  

“File” → “New Project“  

Result auto detection 
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File open  

The program reads the saved parameter file from the disk of the user’s PC to enable continuing 

working with the previous parameter settings. If a direct download on the device is not required, an off-

line task is possible. 

                                     

☞ The file extension of this program is “*.PMT”. 

 

2.1.2 Data Format 

In order to minimize the errors in entering the parameters and to help understanding the parameters, 

the program distinguishes the data in the forms defined as below and it provides the entering method 

that is suitable for the defined formats of each parameter. 

 

Data Format and Entering Method  

Data Format User Interface Entering Method Entering Tool 

Real Number 
 

Enter real number including under 

decimal point 
Keyboard 

Integer 
 

Enter integer Keyboard 

Time 
 

Enter minute or hour : minute Keyboard 

Table 
 

Select item Mouse 

On/Off 
 

Select Mouse 

Letters 
 

Enter letters (Maximum or 3 letters) Keyboard 

True / False 
 

Select item Mouse 

 

“File” → “Upload“  

“File” → “Open“  
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Information  

 You can use “TAB” key to move between entering spaces. 

 If the entered item exceeds the entering range or an error occurs, a flash of “Limit Error” 

message will appear on the upper right corner.  

 When entering letters, numerical digit is also recognized as a letter. 

 

Main Parameter Output Window 

The “Main Parameter Output Window” takes the largest area on the program screen and it has the list 

that allows editing data of the matching parameter. The parameter list has 7 columns, each of which 

has the following meanings. 

Colum title 설명 

D-Reg Register address 

TAG Name of the selected parameter (TAG NAME) 

GROUP Group name 

TYPE Type of data (EU, EUS, ABS) 

MIN/MAX Max. / Min. entering range 

VALUE Data entering space 

 

 You can scroll through the list window by putting mouse cursor over the “Main Parameter Output Window” 

and scrolling the wheel. 

 

 

 

Edit area  

 

 



Chapter 2 CREATING NEW PROJECT AND EDITING  

SAMWONTECH Co., Ltd. www.samwontech.com Page 26 

ENGINEERING UNITS – EU, EUS 

When you change the sensor type (IN-T) or the maximum and minimum values (INRH and INRL) of the 

entering range on the device, the parameters that are indicated as EU or EUS are changed in proportion 

to the existing DATA, but the program is reset to default values. 

 

 EU : Value of engineering unit according to the instrument range 

 EUS : Range of engineering unit according to the instrument span 

 For more details, please refer to the “operation manual” attached with the product at purchase. 
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2.2 ENTERING AND EDITING DATA 

2.2.1 Data Search 

You can check for the overlaps of an entered word in the certain address, tag name and description of 

the currently given parameter data. The respective register address and current values are shown in the 

system log window and you can start editing a parameter by selecting from the search result ().  

 

1 Select “SYSTEM” on the main menu and enter the keyword in the space under the register tab  

 
 

2 View the search result on the “system log view” and double click on the register name of the searched item  
 

 

 

  

 

 
Information  

 If the message on the system log window includes a register address, you can move to the 

address by double clicking on the message. 

 

  

“System” → “Search “  

Double click  

Move to selected parameter 
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2.2.2 Check the Entering Range 

Each register of a device under control of this program has a range, within which you can enter 

information, and it can be checked from the enter list UI. 

1 Select a register in the main output window.  

2 Check the entering range on top of the program and enter the setting value.  

 

 

2.2.3 Compare Entered Data 

The function is for comparing the parameter data of user setting and of connected devices and it gives 

result if the data of the device does not match. Generally it can be used for checking whether the 

parameter settings are properly applied on the device after downloading. 

 

 For more details refer to “Chapter 4. Setting Parameters for Device.” 

  

Check input range 
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2.3 COPY DATA 

2.3.1 Copy Data on Clipboard 

You can copy a section by selecting a desired section on the parameter entering window and using 

“Ctrl + C” keys. You can also paste the copied section on to the desired program window. Each item is 

distinguished with empty spaces and an automatic cell filling is possible when entering with excel. 

1 Select section to be copied 

 Click on the desired section on the main output window -> Drag to select  

 Use “Ctrl + C” keys on the keyboard to copy the selected section. 

 

2 “Paste” on excel or on other editing program. 
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3.1 SAVE DATE 

The parameter information entered by a user or uploaded from a device can be saved as a parameter 

format file (*.PMT) or convert to excel, text or CSV file.  

3.1.1 Save as PMT 

1 Select “File” on the main menu and click on the sub menu, “Save File”. 

 

 

2  Enter the location and name of the file to be saved on the saving window and click on “save” button to 

complete saving. 
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3.1.2 Convert Data 

1 Select “System” on the main menu and click on the “convert to excel” or “convert to text” or “convert to CSV” on 

the sub menu.  

                                 

2 Enter the document information in the cell file converting box and click on the “Export” to convert. 

  

Editable area 

Document information 

Parameter list & data 

Group sheet 
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3.2 PRINT AND PREVIEW 

3.2.1 Print Environment Setting 

You can print the whole selected parameter or in groups.  

1 Select “Print” menu under the main icon on the upper left corner of the program. 

 Quick Print: Directly print the items on the screen. 

 Preview: Select a section to be printed and preview how the printed page will appear. 

 Print Setting: Set the direction of print page, printer and printing range. 

 

 

2 Print Setting (printed when a quick print or print preview is selected) 

 Whole Page: Print the current values from the whole parameter. 

 Selected Group: Print the group that is currently selected. 

 Selected Address: Enter the beginning and end of the parameter address in the range entering space at the 

bottom. 

   

 

Print preview 
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4.1 UPLOAD AND DOWNLOAD THROUGH COMMUNICATION 

If the device allows communication with PC, you can read the parameter setting on the device on PC 

(Upload) or saving the user’s parameter settings on the device (Download). You can Up/Download the 

whole or grouped parameter or selected items only.  

 Information  

 The settings of the communication environment on device and PC must be the same for communication 

connection. 

 You must enter a administrator password of the device to download. Be careful it is not executed by users 

other than the device operation administrator. 

 For more details on the communication connection settings, please refer to the “communication 

environment setting” in “Chapter 1 Introduction to PME.” 

 

4.1.1 Upload 

Save the parameter setting on the connected device with the PC. The saved parameter data can be 

saved into a local storage as a file and can be edited or updated using the editing program. If the 

current project is not created, the program automatically identifies the type and model of the device 

and applies a suitable driver file. 

1 Select “File” on the main menu and click on the sub menu, “Upload”. 

 

2 Set the communication environment and select the device to upload from the communication setting box, and 

click on “OK” button.  

 

1 

2 

3

1 

4 
5 
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○1  Select a section to start upload.  

○2  Set the communication method. You can choose between “ethernet” and “serial” 

○3  Select a device to upload on.  

○4  If the IP address of selected item is different, you can edit and save. 

○5  Start upload by clicking on the “accept” button. 

 

 The device password is not required to upload. 

 

4.1.2 Download 

Save the parameter information set on the program on to the connected device. It requires a 

administrator password of the device, so an authorized user must do the task. 

 Warning  

 For the safety of user, the program is made to not to start download when driving or the password is wrong, but please 

double check to prevent malfunctioning due to wrong values in downloading. 

1 Select “File” on the main menu and click on the sub menu, “Download”. 

  
2 Select the communication environment and device to download on from the communication setting box, and 

click on “OK” button. 

 

1 

2

1 

3

2

1 

4

3

2

1 

5

4

3

2

1 
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Operating Method 

This indicates the method of communicating with the device. It is automatically selected when 

uploading or downloading. User cannot control it. 

 

Applied Range 

It selects the section of which the data is to be updated by communication. You can select the whole 

register or only the groups and items that are selected to update. 

 

Selecting Subject of Application 

Select the device with which you want to communicate with. If the communication is set as “Ethernet 

communication”, you must enter the correct IP address of the device and a administrator’s password is 

required to download for safety. 

 

Serial Communication Parameter 

In general, the settings for RS-232 communication are fixed at data length 8-bit and stop bit 1-bit, but 

the “Comport No” may vary depending on the environment of the user’s PC. The Baud Rate indicates 

the speed at which the communication is performed and it must match the “communication 

environment setting” of the device. 

Communication 

Type 

Item Default Setting Range 

RS-232 

RS-422/485 

PORT NO. COM1 COM1 ~ COM9 

BAUD RATE 115200 9600/19200/38400/57600/115200bps 

PARITY NONE ODD/EVEN/NONE 

STOP BIT 1 1, 2 

RS-422/485 ADDRESS 1 1~30 

 

 
Information  

 You can choose devices for multiple connections when downloading from the list of “select 

subject of application” and a batch processing is possible on the selected devices. 

 Please refer to the system password setting section on the “system initial settings” in installation 

manual to set a device manger password. 

 

  

Explanation 



Chapter 4 DEVICE PARAMETER SETTING  

SAMWONTECH Co., Ltd. www.samwontech.com Page 38 

4.1.3 Checking the Progress 

When uploading / downloading, you can check the communication progress with the device on the 

“Task Progress Information” window. When the communication is progressing properly, the progress bar 

at the bottom indicates the status, but when an error occurs with communication failure, no 

administrator password in downloading or different device types, a message may appear to alert. 

 

 

Stop Communication 

Once you started downloading or uploading, the “OK” button at the bottom of the “Task Progress 

Information” box turns into a “stop” button. When the user clicks on the “stop” button, a warning 

message appears and the communication stops right away. Once you have accepted to stop the 

process, you cannot recover any items. 

 

  

Communication 

parameters 

Model information 

Progress Bar 

Stop communication 
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4.2 VIEW AND RESET DATA SETTING 

4.2.1 Comparing Data between Devices 

You can compare the values of the parameters of device and your setting. Generally it can be used to 

check whether the data set by user is properly saved on the connected device. 

 “System Menu” -> “Compare Parameters”  

 

 

Communication Environment Setting and Progress Check 

For a communication with a device, the communication environment setting and the progress status in 

uploading / downloading are viewed. The result of parameter comparison can be viewed at the 

“program view” at the bottom of the program screen.  

 

 

 

1 

2 

3 

4 

5 
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Viewing Comparison Result 

Before communicating with the device, the communication environment setting should be completed 

and when you select the “compare parameters” icons, Upload / Download will start and the progress 

will be shown at the same time. The result of parameter comparison can be viewed at the “program 

view” at the bottom of the program screen.  

 

 

 

 

 

 

 

4.2.2 Checking File Information 

You can view the information on the file that is being printed or on the device that is connected. 

  “Help Menu” -> “File-info”  

       

Address 

Memory value 

Move to selected parameters 

Progress status dialog 

File path name 

File size 

Result of parameter 

comparison 

User set value 
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4.2.3 Reset Data Setting 

Factory reset all parameters of the device that is being edited. Any parameter information set previously 

by a user is lost. 

 “System Menu” -> “Initialize”  

 

After selecting “Initialize” button, click on “Yes” button on the warning message to start reset or click on 

“No” button to cancel reset.  

 

 

Even when you reset, the connected device maintains the previous data. You may download the reset 

parameter data on the device. 

 Warning  

 Once you start reset, any unsaved data are lost and cannot be recovered. Any necessary data must be saved 

into a file before starting reset. 

 Depending on the version of device, different parameters may exist. For device reset, please refer 

to the operation manual before starting. 
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5.1 ERROR AND USER MESSAGE 

5.1.1 Error Message 

Message Description 

Fail to check the 

administrator's password  

Failed to check the administrator password during communication. 

Model type miss-match The type of the connected device for upload / download and the 

data being edited does not match. 

Verify model type NG. “Automatic Device Identification” has failed to connect and read the 

device code. 

Connection failed. Check the 

communication settings. 

Failed to connect with device. Please check the communication 

environment settings. 

No response There is no response from the device. The communication has failed. 

 

5.1.2 User Message 

Message Description 

All set registers parameters 

will be reset. 

Once you start “Parameter Reset”, all data settings will be lost. 

Miss-matched parameters 

count 

Indicates number of different data in processing “Compare 

Parameters” command. 

Stop the communications? Asks whether to really stop uploading / downloading with 

communication. 

All unsaved parameters will 

be lost. Exit the program? 

Suggests saving data that is being edited when exiting the program. 
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